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Organisation and Conditions for Assessment 

 

 
The assessment is designed to test the candidate’s ability to apply knowledge and understanding and 

practical skills, developed through study of the Relational Database Systems and Using Information 

Units.  The mark out of 60 should be submitted to the SQA unscaled.  This will be combined with the 

examination mark out of 140 to establish the candidate’s overall grade of award.  This mark should 

also be used in conjunction with internal examination marks or other evidence in the preparation of a 

candidate’s estimated grade of performance. 

 

The notional design length for the assessment is 8–10 hours.  However, a candidate may be permitted 

additional time if required. 

 

The assessment is to be undertaken under “open book” conditions, but under the supervision of a 

teacher or lecturer to ensure that the work submitted is the candidate’s own work.  The teacher or 

lecturer may give the candidate guidance and/or help if requested.  Any such help should be reflected 

in the marks awarded.   

 

Once the task has been completed and marked, it should not be returned to the candidate for 

further work. 

 

These instructions are designed to be used in conjunction with data files provided with the electronic 

distribution of the task.  These can be downloaded from the SQA secure website. 
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Special Arrangements for Higher Coursework 2011-2012 

 

Centres are asked to pay special attention to the following arrangements. 

 

 
Candidates are not required to spend time entering data into a database.  Instead, the data should be 

prepared beforehand and provided to candidates by the centre. 

 

To facilitate this, Microsoft Access (2003 format) and Filemaker (v.7) as well as text (tab) delimited 

and csv data files have been provided.  It is intended that candidates will be provided with three 

versions of the database. 

 

The first database (PAFI Task 2) contains three of the tables of the system; Venue, Course and 

Member.  Each table will have all attributes correctly implemented although the tables will not be 

related.  Candidates will be required to create the Certificate table from the completed data dictionary 

and then set up the relationships between all the tables.  Candidates will be required to submit a 

printout of the Documenter (or equivalent) of the Certificate table only as evidence for Task 2(a).  

Evidence for Task 2(b) could be generated from the Documenter again (selecting only Relationships 

in the options) but the evidence must show three correct one-to-many relationships.  Candidates will 

not use their database structures to complete Tasks 3-5.  Instead, centres should issue candidates with 

the second, fully populated database. 

 

The second database (PAFI Tasks 3-5) will be a complete implementation of the system.  This will 

include all validations, relationships etc – ie an exact implementation of the data dictionary provided 

to candidates at Task 2.  This working database should be issued to candidates after Task 2 has been 

submitted.  Candidates must use this working database to complete Tasks 3-5. 

 

A further database (PAFI Task 6) should be issued to candidates to allow Task 6 to be completed. 

 

Microsoft Access and Filemaker files are provided.  Centres using other systems will require to create 

all three versions of the databases from the tab separated file and csv files provided.  These files can 

also be used if centres encounter any difficulties with the supplied Access or Filemaker databases. 

 

Additional notes follow which detail how candidate evidence is to be generated. 
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Notes: 

 

Candidates may be reminded that this Coursework is taken under “open book” conditions.  As 

such, use may be made on on-line help facilities, notes or any other support materials in the 

course of carrying out tasks. 

Candidates should be given a copy of the marking grid from Section 3 (not the detailed marking 

instructions) before starting the task so that they are aware of the mark distribution for each part. 

The entire Coursework Task consists of ten tasks.  Centres should take note of the points detailed 

below for each task. 

Task Evidence 

1 Hardcopy of proforma provided or can be produced by the candidate.  Task 1 must be 

completed and data dictionary handed in for marking before the materials for  

Task 2 are issued. 

 

2 (a) Documenter (MS Access) printout or equivalent showing table structure for the 

Certificate table only. 

 

2 (b) Printout showing correct cardinality of relationships (Documenter in Access can be used 

to produce only the relationships information through the options). 

 

o In FileMaker Pro8, to get a printout of the design, candidates should 

adhere to the following instructions. 

(1) Select the “Define” option from the File menu and then select the 

“Database” option from the sub-menu. 

(2) Click on the Tables tab. 

(3) Highlight both tables by clicking on the name of the first table then 

holding down the shift key and clicking on the other table. 

(4) Click on the Print button. 

 

o In MS Access, to get a printout of the design, candidates should adhere to 

the following instructions.   

(1) Select the “Analyze” option from the Tools menu and then select 

the “Documenter” option from the sub-menu. 

(2) Select the table(s) required and then click Options button. 

(3) Make sure that the following options are checked/selected: 

 Include for Table 

 Properties 

 Relationships 

 Include for Fields 

 Names, Data Types, Sizes and Properties 

 Include for Indexes 

 Names and Fields 

(4) Required table design is displayed on screen and can be printed. 
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Task 2 (b) also requires a printout or hardcopy of the relationships. 

o Printing Relationships in FileMaker 8. 

(1) Select the “Define” option from the File menu and then select the 

“Database” option from the sub-menu. 

(2) Click on the Relationships tab then click on the Print button. 

o Printing Relationships in Access 

(1) Open the Relationships window. 

(2) Select the “Print Relationships” option from the File menu. 

3 Printout of report. 

 

4 Printout of report. 

 

5 Hardcopy that clearly shows use and details of macro or script (again, available through 

Documenter in Access – simply change options in dialogue box). 

 

6(b) Printouts of spreadsheet showing data and formulae. 

 

7 Screenshot of conditional formatting dialog. 

 

8 Screenshots of custom list creation and use in sort. 

 

9 Printouts of macro scripts. 

 

10 Screenshots to provide evidence as required. 

 

 

Screenshots for multiple tasks may be combined into a single page/document but should be 

clearly labelled as to which task each screenshot is evidence for. 
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Coursework Task: The Professional Association of Fitness Instructors 

(PAFI) 
 

 

Higher Information Systems Coursework Task 2011-2012 

 

Background 
 

The Professional Association of Fitness Instructors (PAFI) is an organisation that delivers courses and 

issues certificates for fitness instructors.  Courses are run at several venues throughout Scotland.  All 

venue details are stored as part of a relational database in a table called Venue.  Venue names are 

unique. 

 

Fitness instructors register with PAFI and their contact details are stored in a Member table.  

Members are allocated a unique ID. 

 

The details of the courses that PAFI delivers are stored in a Course table.  Course IDs are unique.  

Each course can only be run in one venue, although the same venue can host many courses.  Although 

courses may have the same title, each course can only be run at a specific level – Level 1, Level 2 or 

Level 3. 

 

For example: 

Course 456 Circuit Training Level 1 

Course 557 Circuit Training  Level 3 

 

At the end of a course members are assessed.  Those who pass are awarded certificates depending on 

how well they have performed.  The certificates are awarded at Platinum, Gold or Silver level.  PAFI 

stores the details of certificates awarded to members in a table called Certificate. 

 

PAFI use a relational database to manage this information. 

 

The relational data model is shown on the next page. 
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Entities 
 

The resulting data model is shown below where primary keys are shown in bold and underlined, 

while asterisks (*) indicate foreign keys.) 

 

Member  

 

 

Course (CourseID, CourseTitle, CourseLevel, CourseDate, VenueName*) 

 

Venue (VenueName, VenueAddress, VenueCity, VenueTelephone) 

 

Certificate (MemberID*, CourseID*, AwardLevel, AwardDate) 

 

The entity-relationship diagram for the system is shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(Member ID, Forename, Surname, MemberAddress, MemberTown, MemberPostcode, 

DateofBirth) 

Member Venue Course Certificate 
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A data dictionary has been produced prior to implementation in a relational database.  Part of this is 

shown below. 

 

Data Dictionary 

 
Entity Attribute PK/ FK Data 

Type/Size 

Unique Required Validation 

Member MemberID PK Text (7) Y Y  

 Forename  Text (30) N Y  

 Surname  Text (30) N Y  

 MemberAddress  Text (30) N Y  

 MemberTown  Text (15) N Y  

 MemberPostcode  Text (8) N Y  

 DateofBirth  Date N Y  

       

Course CourseID PK Number Y Y  

 CourseTitle  Text  (30) N Y  

 CourseLevel  Number N Y 1 or 2 or 3 

 CourseDate  Date N Y  

 VenueName FK Text (30) N Y Lookup from Venue 

       

Venue VenueName PK Text  (30) Y Y  

 VenueAddress  Text  (40) Y Y  

 VenueCity  Text  (15) N Y  

 VenueTelephone  Text (12) N Y  

       

Certificate MemberID PK/FK Text  (7)    

 CourseID PK/FK Number    

 AwardLevel  Text  (8) N Y  

 AwardDate  Date N Y  

 

 

 

Task Evidence Required 

1 Your teacher/lecturer will provide you with a partially 

completed data dictionary for the Certificate table. 

 

Using the background information provided, complete the data 

dictionary for the Certificate table by making appropriate 

entries in the shaded areas as indicated. 

 

Completed data 

dictionary 

(Proforma 1) 

 

You must now submit your answer to Task 1 to your teacher/lecturer. 
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Before attempting the tasks in this section ask your teacher/lecturer for a completed data 

dictionary.   

 

You will also need access to pre-prepared database tables.  

 

You MUST complete tasks in the sequence indicated. 

 

 

Task Evidence Required 

2 Database tables have been created for the Venue, Member and Course tables. 

 (a) Using the completed data dictionary issued by your 

teacher/lecturer, create the Certificate table.  You should 

pay particular attention to: 

 data type (text size) 

 required 

 validation – where appropriate ensure that only 

valid values may be entered 

 primary and foreign keys 

 

Hardcopy (printout or 

screenshots) of table 

structure including 

field types, validation 

checks etc. 

 (b) Set up/edit the relationships between all the tables as 

indicated by the entity-relationship diagram. 

Hardcopy (printout or 

screenshots) of 

relationships between 

tables. 

 
You must now submit all hardcopies for Task 2 to your teacher/lecturer. 
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Ask your teacher/lecturer for the completed database.  This database must be used to carry out 

Tasks 3-5. 

 

A market researcher from PAFI was interested in investigating the popularity of courses.  The 

following report was produced. 

 

 
 

The researcher now wants a similar list but this time it should show the number of certificates 

awarded to each member.  The list should be ordered in alphabetical order of surname. 

 

Task Evidence Required 

3 Using appropriate database functions, create a report that 

displays the total number of Certificates awarded to each 

member.  The report data should be ordered by surname of the 

member.  Your report should include only the full name 

(forename and surname) of the member and the total number of 

certificates awarded.   

 

Printout of 

report/layout 
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PAFI have been monitoring which of the venues has been awarding the most certificates and created 

the report shown below. 

 

 
 

They have decided that the report does not provide enough detail and have asked you to improve the 

information shown by displaying a breakdown of how many members were awarded certificates for 

each course at each level in each venue.  The total number of certificates at each venue should be 

included.  A sample layout has been provided below. 

 

 
 

 
Task Evidence Required 

4 Create a report as follows: 

 

 Show, for each venue, the number of certificates they 

have awarded for each level of each course. 

 All data should be in alphabetical or ascending order. 

 Include the venue name, the level of the course, the name 

of each course, the number of certificates for each course 

and the total number of certificates for each venue. 

Printout of 

report/layout 
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The market researcher thinks it would be helpful to view a list of courses that are held at each 

venue. They have decided to create a Venue Selector form/layout where each venue is listed. 

When a specific venue is chosen the Venue Selector screen closes and is replaced by a list of 

all courses at the chosen venue. The list of Courses also includes a link back to the Venue 

Selector screen, as is shown below using the “Gymworld” venue as an example. 
 

 

 

 

 

 

 Fig (a) Venue Selector Form Fig (b) Courses at chosen venue 

 

 

Task Evidence Required 

5 Your PAFI database already includes the Venue Selector form 

shown in Fig (a) above. 

 

Choose one venue and create, using a macro or script, a 

navigational link to a separate form/layout that shows only the 

courses available from that venue, as shown in Fig (b).  Include 

on this form/layout a link back to the Venue Selector screen, 

again through the use of a macro or script. 

 

Each navigational link should close the current form/layout 

and open the selected form/layout. 

 

Printout of 

report/layout 

 

Printout of macros/ 

scripts used to control 

navigational features 

 



Scottish Qualifications Authority 17 
Coursework Task  

Higher Information Systems 2011/2012 

Ask your teacher/lecturer for a copy of the database PAFI Task 6.  You must use this 

new copy for the following task. 

 

The market researcher wants to carry out some financial operations on the data from the 

PAFI database.  The data from the report on the number of certificates awarded at each venue 

was exported to a spreadsheet. Details about the price of each course and course income for 

each venue were added.  Subtotals were calculated for each venue and formatting was then 

applied.  The final spreadsheet is shown below. 
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Task Evidence Required 

6 You must use the new version of the database

(PAFI Task 6) to carry out this task. 

 

You are going to create the spreadsheet from the results of a 

query in the new database. 

 

 

 (a) Export the results from the query/layout named Task 6 

into a spreadsheet package. 

 

Printouts of data and 

formulae 

(b) In creating the spreadsheet you must: 

 Create blank columns for Course Price and Course 

Income. 

 Enter the details about the course prices: 

Level 1 course - £100 

Level 2 course - £160 

Level 3 course - £225 

into a lookup table. 

 Use a lookup table and an appropriate formula to 

complete the Course Price column. 

 Insert a formula to calculate Course Income from 

each course. 

 Use an appropriate function of the spreadsheet 

package to automatically create and display the 

subtotals for each venue. 

 Format the spreadsheet in the same way as the 

example given. 

 Add a footer with your name and the date. 

 Print your spreadsheet 

To show the data 

To show the formulae used 

 

Ask your teacher/lecturer for the Spreadsheet file Certificates by Members. 

 

Task Evidence Required 

7 Apply conditional formatting to this spreadsheet to shade the 

cells for each award level in a different colour/shade. 

 

For example platinum, gold, silver in successively lighter 

shades of grey. 

 

Screenshot of dialog 

used to create this 

formatting. 
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Using a spreadsheet of this size can sometimes make analysing data difficult.  One way to make 

analysing easier is to use a sort. 

PAFI would like the spreadsheet sorted in order of award level with Platinum first, then Gold, then 

Silver.  A normal alphabetic sort will not produce the correct result and so a custom sort order must be 

created. 

 

Task Evidence Required 

8 Create a custom list with the values Platinum, Gold and Silver.  

Use this custom list to sort the data on award level with 

platinum first then gold then silver. 

 

 

Screenshot to show 

evidence of custom 

list creation and use 

in sort. 
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Administrators at PAFI sometimes require to sort data in different ways on many columns.  

They use macros to make this tedious job a little easier. 

 
Task Evidence 

Required 

9 (a) Create a macro in this work book to sort the spreadsheet and assign it 

to a keyboard shortcut.  The macro should sort in alphabetical order 

of Course Title, then alphabetical order of Venue Name. 
 

Printouts of  

macro scripts 

(b) Create a macro to sort the spreadsheet to show members’ full names 

(Forename and Surname) in alphabetical order of Surname, then 

Forename and then for each member their courses in order of Course 

Level.  Where more than one course has been passed at the same level 

the courses passed should be in alphabetical order. 

 

The following table may help you organise your sorts. 

 

Column Order Importance of Sort 

Forename Alphabetical 2 

Surname Alphabetical 1 (most important) 

Course Level Descending 3 

Course Title Alphabetical 4 (least important) 

 

The top of your spreadsheet should look similar to this . . .  
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You have become a member of PAFI and enrolled for a course.  You are going to use personal 

information software to manage this. 

 
Task Evidence Required 

10 (a) PAFI will contact you with information regarding courses by 

email. 

 Create a folder to store all mail you receive from PAFI. 

 Create a rule/filter to automatically place all emails 

received from PAFI.co.uk into your new folder. 

 All email to PAFI regarding courses should be sent to 

courses@PAFI.co.uk.  Add this as a new contact to 

your address book/contact list 

 

Printouts/screenshots 

to show evidence of 

each 

(b) Using personal information software create a calendar and 

add the following information about a course you have 

enrolled in. 

Course Title: Advanced Fitness 

Dates: 5, 12, 19 May 

Time: 9am – 12 noon 

Add the date of the Higher Information Systems 

examination. 

Print out a section of your calendar which shows these 

entries.  

 

 
 (c) EITHER 

 (i) To remind you about your examination use your 

calendar to set up a reminder/notification/alert to be 

emailed to you some days before the examination. 

  OR 

 (ii) Create a suitable signature to be included in emails 

which you send. 
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Marking Grid 
 

 

Name   Date     

 
 

Task Possible 

Marks 

Actual  

Marks 

Evidence Comment 

1 5  Completed data 

dictionary 

 

2(a) 5  Printout of table 

structure 

 

2(b) 2  Printout showing 

relationships 

 

3 5  Printout of report  

4 9  Printout of report  

5 4  Printout of 

macros/scripts 

 

6(a) 2  Export query  

6(b) 4  Lookup  

 2  Subtotals  

 2  Formatting  

7 2  Conditional format  

8 3  Custom sort  

9(a) 2  Macro  

9(b) 4  4 column sort  

10(a) 3  Email  

10(b) 4  Calendar  

10(c) 2  Notification/Signature  

 60 
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Appendix 1 

 

Task 1 Proforma 

 

 

Name  

Data dictionary for Certificate entity 

Attribute Keys 
Data 

Type/Size 

Un

iq

ue 

Re

qd 
Validation 

MemberID PK/FK Text (7)    

CourseID PK/FK Number   - 

AwardLevel  Text (8) N Y  

AwardDate - Date N Y  
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Appendix 2 

 

Completed Data Dictionary 

 

Only to be issued after completion and submission of Task 1 

 

 

Entity Attribute Keys Data 

Type/Size 

Uni 

que 

Requ 

ired 

Validation 

Member MemberID PK Text (7) Y Y  

 Forename  Text (30) N Y  

 Surname  Text (30) N Y  

 MemberAddress  Text (30) N Y  

 MemberTown  Text (15) N Y  

 MemberPostcode  Text (8) N Y  

 DateofBirth  Date N Y  

       

Course CourseID PK Number Y Y  

 CourseTitle  Text (30) N Y  

 CourseLevel  Number N Y 1 or 2 or 3 

 CourseDate  Date N Y  

 VenueName FK Text (30) N Y Lookup from Venue 

       

Venue VenueName PK Text (30) Y Y  

 VenueAddress  Text (40) N Y  

 VenueCity  Text (15) N Y  

 VenueTelephone  Text (12) N Y  

       

Certificate MemberID PK/FK Text (7) N Y Lookup from Member 

 CourseID PK/FK Number N Y Lookup from Course 

 AwardLevel  Text (8) N Y Platinum, Gold or Silver 

 AwardDate  Date N Y  
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Detailed Marking Instructions 
 

Strictly Confidential 
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Detailed Marking Instructions – Do not issue to candidates. 

 
    Marks 

1 

Data Dictionary 5 

Required:  memberID/CourseID 1 

Unique Member ID/CourseID  2 

 Lookup for MemberID/Lookup for CourseID 1 

 Validation AwardLevel 1 

2 

Create Certificate 

table  
5 

Data type/size correct 1 

PK correct 1 

Required correct 1 

Validation correct – Lookups/FK 1 

Limit to list or correct rule 1 

 

Links between tables 2 

3 correct one-to-many relationships 

2 correct one-to-many relationships 

0 or 1 correct 

2 

1 

0 

3 
Report showing total 

number of 

certificates awarded 

to each member 

5 

Calculate total for each course (query) 2 

Sort surname ascending order 1 

Only required fields showing 1 

Layout (change total field name, field names ad 

data visible). 

1 

4 

Report showing total 

number of 

certificates arranged 

by each promoter in 

each city 

9 

Grouped by Centre 1 

Grouped by level 1 

1st sort condition (Venue Ascending) 1 

2nd/3rd sort condition (Level Ascending/Course 

Ascending) 

1 

Total number of Certificates for each course 1 

Only required fields  1 

Layout (change field names, field names and data 

visible) 

1 

Total by venue 1 

Report completed with no help 1 

5 

Navigation links 4 

Navigation link from selector to list of Certificates 

(close, filter, open) 

2 

Navigation from list of Certificates to venue 

selector (close, open) 

2 
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    Marks 

6(a) 
Export query 2 

Query exported to spreadsheet 

With help

2 

1 

6(b) 

Lookup 4 

Lookup table created 1 

Range named or use of absolute references 1 

Lookup formula correctly applied to correct column  

with help 

2 

1 

 
Subtotals 2 

Create subtotals automatically 

With help 

2 

1 

 

Formatting 2 

Currency 

Alignment 

Columns names appropriately 

All 3–2 

marks 

Any 2–1 

mark 

7 
Conditional 

Format 
2 

Conditional format applied with 2 or 3 conditions 

1 condition or with help 

2 

1 

0 

8 

Custom Sort 3 

Custom list created 

Sort using list 

With help 

3 

2 

1 

9(a) 
Macro 2 

Macro recoded and keyboard shortcut assigned 1 

All 3 sorts correct 1 

9(b) 

4 column sort 4 

4 columns correct 4 

3 columns correct or 4 columns but wrong order 2 

With help 1 

10(a) 

Email 3 

Create folder 1 

Create rule/filter 1 

Create contact 1 

10(b) 

Calendar 4 

Titles 1 

Dates 1 

Times 1 

Print calendar 1 

10(c) 
Notification 2 

Email notification or signature set up  

With help 

2 

1 
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Task 3 
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Task 4 
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Task 4 (continued) 
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Task 5  

Using named range 
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Task 5 (continued) 

Using absolute References 

 

  

 

 
 


